CEMENT

WELLBORNE
CEMENTING MODEL
Version 2

USER'S MANUAL

Flow Rate vs Elapsed Time

Elapsed Time (min)

Rate (gpm)

DEA 67
PHASE II

MAURER ENGINEERING INC.
2916 West T.C. Jester
Houston, Texas 77018
Table of Contents

1. INTRODUCTION .......................................................................................... 1-1
   1.1 BACKGROUND ......................................................................................... 1-1
   1.2 NEW FEATURES OF CEMENT 2.0 ....................................................... 1-1
   1.3 GENERAL FEATURES ............................................................................. 1-1
   1.4 COPYRIGHT AND DISCLAIMER .......................................................... 1-3

2. GETTING STARTED ....................................................................................... 2-1
   2.1 HARDWARE AND SYSTEM REQUIREMENTS ........................................ 2-1
   2.2 INSTALLING CEMENT ............................................................................ 2-1
   2.3 RUNNING CEMENT ................................................................................ 2-2
   2.4 QUICK TOUR OF CEMENT 2.0 ............................................................... 2-2

3. INPUT ............................................................................................................ 3-1
   3.1 REQUIRED INPUT DATA ....................................................................... 3-1
   3.2 INPUT WINDOWS .................................................................................... 3-1
      3.2.1 MAIN PROJECT SCREEN ............................................................. 3-2
      3.2.2 SURVEY SCREEN ......................................................................... 3-4
      Entering/Editing the Survey Data ............................................................. 3-5
      3.2.3 FORMATION SCREEN ................................................................... 3-7
      3.2.4 TUBULARS SCREEN ..................................................................... 3-8
      3.2.5 FLUIDS SCREEN ........................................................................... 3-10
      Wellbore Schematic/Section Volume Calculation Screen ....................... 3-12
      3.2.6 INPUT SCREEN MENUS ............................................................... 3-13
      File Menu .................................................................................................. 3-13
      Run Menu .................................................................................................. 3-14
      Output Menu ............................................................................................. 3-14
      Utility Menu .............................................................................................. 3-14
      Help Menu ................................................................................................ 3-15
   3.3 ERROR DETECTION FOR INPUT DATA .............................................. 3-16

4. OUTPUT ........................................................................................................ 4-1
   4.1 INTRODUCTION ....................................................................................... 4-1
   4.2 THE OUTPUT WINDOW ........................................................................... 4-1
      4.2.1 MAIN OUTPUT SCREEN ............................................................ 4-1
      4.2.2 FLOW ANIMATION SCREEN ....................................................... 4-4
      4.2.3 WELL SCHEMATIC PREVIEW WINDOW .................................... 4-6
      4.2.4 REPORT SETUP WINDOW .......................................................... 4-7
Table of Contents (Cont’d.)

4.2.5 GRAPH SETUP WINDOW  .................................................... 4-8
4.2.6 OUTPUT SCREEN MENUS  .................................................... 4-9
   File Menu ............................................................................. 4-9
   Window Menu ..................................................................... 4-10
   Output Setup Menu .......................................................... 4-11
   Graph Style Menu ............................................................ 4-11
   Help Menu .......................................................................... 4-12

5. GETTING HELP ................................................................. 5-1
   5.1 CONTACTING MEI ......................................................... 5-1
   5.2 REPORTING PROBLEMS ............................................... 5-1
      BUG REPORT/ENHANCEMENT SUGGESTION FORM ......... 5-3

APPENDIX A — Common Problems and Solutions .......................... A-1
   A.1 INTERNATIONAL KEYBOARD SETTINGS ....................... A-1
   A.2 POTENTIAL LIBRARY FILE PROBLEMS ....................... A-3
   A.3 PRINTER SELECTION ................................................... A-4
1. Introduction

1.1 BACKGROUND

CEMENT was developed by Maurer Engineering Inc. under dual sponsorship of project DEA-44 To Develop and Evaluate Horizontal Well Technology and project DEA-67 To Develop and Evaluate Coiled-Tubing and Slim-Hole Technology. The program runs in the Windows environment on IBM-compatible computers with Microsoft Windows 3.1, 95 or later versions.

CEMENT analyzes the complex phenomena of multistage fluid placement in a wellbore and is a very useful planning tool prior to field operations. Although generally designed for cementing (i.e., the text-box labels etc.), the program can be used for any multistage, multifluid pumping operation. The well-recognized U-tubing phenomenon is addressed, along with equivalent circulating density (ECD) and pressure at the bottom of the hole. The program predicts return rates during the job, including periods of free fall when the return rate is not well correlated with pump rate. A variety of potential problems with formation breakdown and of low to no returns can be avoided by using CEMENT at the planning stage.

1.2 NEW FEATURES OF CEMENT 2.0

CEMENT 2.0 is a major upgrade of the previous version CEMENT 1.2. Among the new features are the option for reverse circulation, the capability to vary the choke pressure during pumping, and a new large database of tubular geometries and properties. Users can now input pore and frac gradients and have the program automatically check for dangerous pressure conditions along the wellbore, including both pore/frac pressure limits at all exposed formation and collapse/burst limits of the casing. In previous versions, this type of safety check required multiple runs.

The "look and feel" of the program is also significantly improved. Intuitive tabs and icons can be used to quickly navigate through the program. Input data-file management is improved, and a variety of options for customizing graphics and producing professional-style printouts which include your company's logo are included.

Another significant improvement is the addition of a complete Help system. Descriptions and instructions are provided for every input and output screen. The Help system is also context sensitive to allow intuitive navigation by pointing and clicking the mouse on the screen where the user's question originates.

1.3 GENERAL FEATURES

CEMENT runs in the Microsoft Windows environment. It is assumed that the user is familiar with basic operation in Windows. For comprehensive information about Windows, the reader is directed to other texts (for example, see Mastering Windows® 3.0 by Robert Cowart, Sybex Inc., 1990).

The important features of the CEMENT Wellbore Cementing Model include:

1. Manages up to 20 different fluid stages, and each can be pumped at 10 different rates, including shut-in periods
Chapter 1. Introduction

2. Allows up to 20 sections of casing and 20 well intervals
3. Handles vertical, deviated and horizontal wells
4. Calculates the length of the section where the fluid is in free fall
5. Computes pump pressure, and pressures and ECDs at up to three locations along the wellbore
6. An animation feature is included that simulates multistage pumping operations and shows the position of fluid fronts as the job progresses
7. Provides a choice of systems of units, including English, SI (metric), or any user-specified custom combination

The Output Window provides a number of informative graphs and text reports including:

1. **Simulation Report.** All parameters calculated by CEMENT in a convenient table format.
2. **Flow Rate In and Out versus Elapsed Time.** A comparison of inflow to returns shows the expected impact of free fall.
3. **Free Fall and Fluid Fronts versus Elapsed Time.** The length of the section in free fall and the position of the leading edge of each fluid stage are charted.
4. **Pressure versus Elapsed Time.** The pressure throughout the job is charted at a strategic location, typically at the bottom of the hole.
5. **Equivalent Circulating Density (ECD) versus Elapsed Time.** Pressure history at the zone of interest is also plotted as an ECD.
6. **Free Fall Pit Gain versus Elapsed Time.** The predicted effect of free fall on pit volume allows accurate operations planning.
7. **Formation/Pipe Safety Check Report.** This table report shows the minimum and maximum pressures expected during the job at multiple positions along the wellbore. These data highlight potential problems with lost circulation, fluid influxes, and casing collapse/burst.
8. **Minimum/Maximum Annular Pressure Profile.** Minimum and maximum pressures during the operation at the formation face are plotted for multiple positions along the wellbore.
9. **Tubing Burst/Collapse Pressures.** Minimum and maximum pressures for collapsing or bursting the casing are plotted for multiple positions along the wellbore.

Variables printed in the text report and curves plotted in the graphs can be selected by the user. All output data may be printed, copied to the Clipboard for export into other Windows applications, or stored to disk.

© 1997 Maurer Engineering Inc.
Chapter 1. Introduction

1.4 COPYRIGHT AND DISCLAIMER

This software and manual are copyrighted (1997) by Maurer Engineering Incorporated. The copyright agreement and usage restrictions are described on the screen that immediately follows the opening title screen (see below). By selecting OK at the bottom of this screen, the user signifies that he agrees to abide by the restrictions as presented. No warranty or representation, either express or implied, is made with respect to this program and documentation, including their quality, performance, merchantability, or fitness for a particular purpose.

© 1997 Maurer Engineering Inc.
Chapter 1. Introduction
2. Getting Started

2.1 HARDWARE AND SYSTEM REQUIREMENTS

CEMENT is written in Microsoft Visual Basic®. It runs in either the standard or enhanced mode of Microsoft Windows 3.x or 95. The minimum hardware requirements are:

- IBM-compatible machine with 80386 processor
- Hard disk (4-5 megabytes of storage space required)
- Mouse
- VGA or compatible display

2.2 INSTALLING CEMENT

Program Disks

CEMENT is shipped on four 3½-inch disks containing multiple files. We strongly recommend that all Visual Basic library files used by CEMENT be stored in the CEMENT folder. This will avoid potential conflicts with other software, based on earlier (or later) versions of the same Visual Basic library files (see Appendix A). The CEMENT executable file (CEMENT2.EXE) should also be placed in the folder (default "C:\CEMENT2", or as specified by the user) along with the example data file Cemtest.RC1. All of these procedures will be accomplished during the set-up procedure described below.

Backup Disks

It is recommended that the original disks be kept as a backup set and stored in a safe location, and that working disks be made from them. A copy of the original disks can be made using the COPY or DISKCOPY command in DOS, or “Copy Diskette” on the disk menu in the File Manager in Windows 3. In Windows 95, run Windows Explorer, double-click “My Computer”, single-click the icon for your floppy drive, and select “Copy Disk” from the File menu.

Installation

The following procedure will install CEMENT from the floppy drive onto the working directory of the hard disk (e.g., copy from A: floppy drive onto C: hard drive directory CEMENT).

1. In Windows 3.x, open the Program Manager and choose Run from the File menu. Then type “A:setup.” In Windows 95, choose Run... from the Start menu. Then type “A:setup.”
2. Follow the on-screen instructions.

After set up, there will be a new Program Group in Windows 3.x containing the application. A new folder (“MEI Applications”) will be created in Windows 95 to hold the shortcut to CEMENT and other MEI software.
Chapter 2. Getting Started

Note: to move other ME1 applications into this folder, select Start → Settings → Taskbar → Start Menu Programs → Advanced. Then, double-click "Programs" to display the folders in your Programs menu. Drag and drop shortcuts to other MEI programs into the MEI Applications folder.

2.3 RUNNING CEMENT

In Windows 3.1, start CEMENT from the MEI Application Group Window. Double-click the “CEMENT” icon, or when the icon is focused, press <ENTER>.

In Windows 95, select CEMENT under the MEI Applications Group from the Program Menu.

Both the program front window and the printouts can easily be customized with the addition of your company’s logo. To add your logo, place a bitmap named “Clogo.bmp” into the local CEMENT directory. (Square bitmaps are preferred.)

The design and operation of the input screens in CEMENT 2.0 are described in Chapter 3. Output screens and features are discussed in Chapter 4. For assistance with the program, contact ME1 using information presented in Chapter 5.

2.4 QUICK TOUR OF CEMENT 2.0

The following quick tour will give the new user a rapid overview of the basic structure and features of CEMENT 2.0.

Install:

1. Start Windows (3.1 or later version).
2. Insert CEMENT Disk 1 in drive A:
Chapter 2. Getting Started


4. Type A:SETUP and press Enter. Follow the on-screen instructions.

Run:

5. Launch CEMENT. Double-click the CEMENT icon (Windows 3.x), or select CEMENT from the Programs list under the Start menu (Windows 95).

6. Click OK in the Introductory Window to accept the terms and conditions of the program license.

Input:

7. In the Main Window, choose “Open File...” from the File menu.

8. From the “Open RC1 File” dialog box, click the drive C: in the drive list box, double-click the “CEMENT” subdirectory (or the directory specified during set-up), click “Cemtest.RC1” in the file list box, and click OK. (Please note that parametric values in the example project file are for illustration only and should not be considered as preferred values.)

9. Click each of the input window tabs (Main, Survey, Formation, Tubulars, and Fluids/Pressure) to view each page of input data.

10. Select “Start” from the Run menu (or click the runner icon). The progress of the calculation will be displayed in the upper right corner.

Output:

11. After the Output Window is opened, select text reports or graph windows of interest to enlarge for viewing in more detail. Click on [ ] to zoom a graph to full screen and then [ ] to replace the graph into the tiled windows. Another option: double-click anywhere on the graph to maximize it; double-click again to restore the tiled display.

12. To print the summary text report, click on the Simulation Report window to make it active (its title bar background will turn blue) and select “Print Report/Graph” from the File menu.

13. To print a copy of any active graph window, select “Print Report/Graph” from the File menu.

14. Choose “Return to Project Window” from the File menu to return to the input window and then click “Exit” from the File menu to close the program.
Chapter 2. Getting Started
3. Input

3.1 REQUIRED INPUT DATA

Data management is greatly simplified in CEMENT 2.0. The previous filing system design in CEMENT 1.2 included separate files for each type of data (.WDI, .SDI, .TDI, etc.). This storage design has been replaced by a single file (with extension .RCI) that stores all identification, survey, and parametric data. Wellbore survey data files used by other MEI software (in *.SDI files) can be imported into and exported from the program. Input data required to run CEMENT 2.0 are listed below.

Well Data:

1. Well/project description (company name, project name, well location, etc.) (optional)

Survey Data:

2. Directional survey data for the well, including survey depth, azimuth and inclination

Formation Data:

3. Pore and fracture pressures or gradients

Tubular Data:

4. Surface line length and ID
5. Lengths, ID, and OD of casing sections
6. Depths and IDs of well intervals
7. Measured depths of zones of interest
8. Free-fall control tool depth and its total flow area (optional)

Fluid and Pressure Data:

9. Fluid descriptions, rheology model(s), mud weights, and pumping schedules
10. Back-pressure schedule

Data can be entered and displayed in English or metric units, or using a custom combination defined by the user. All input data saved on disk or in memory are in the English system of units.

3.2 INPUT WINDOWS

In the Main Project Window of CEMENT, there are five different pages for organizing input data. Each is accessed by clicking on its tab below the icon tool bar. Functions and parameters on each screen are described in the sections which follow.
Chapter 3. Input

3.2.1 MAIN PROJECT SCREEN

The Main Project Screen is the initial navigation point for controlling CEMENT.

1. Menu Bar. The function of the pull-down menus in CEMENT is similar to that in other Windows applications. A description of all functions and features is presented later in this chapter in section 3.2.6.

2. Tool Bar. Tool bar icons can be used to quickly access commonly used functions. Most of the icons are short-cuts for menu options. The functions of the icons are:

- **New Project.** Clears all input data.
- **Open File.** Activates the open file window.
- **Save.** Saves all input data to current file name. If the project is new, the *Save As...* window is activated automatically.
- **Print.** Activates the print options window.
- **Data Report Preview.** Activates a window for previewing the current input data report prior to printing.
- **Run.** Initiates hydraulics calculations. Progress can be monitored on Status Bar.
- **Output.** Goes to output screens without recalculating. Not active if calculation has not yet been performed.
- **Units.** Opens the Units Selection window. The user can select English, SI, or any custom combination of units.
Chapter 3. Input

Help. Opens the Help system for CEMENT.

Calculator. Causes the Windows utility calculator to pop up.

Page Tabs. Switching between the five input screens for entering or checking data is simple—just click on the corresponding tab. The colored circle on the left side of each tab is like a traffic signal; a red light means data entry is not yet complete on that page. A green light on all tabs means that all required data have been entered and the calculations can be launched.

The status light on the first tab (Main) does not refer to that screen, since all these data are optional. Rather, this light signals conflicts and inconsistencies between any of the other four screens. An example of this type of problem is when the casing string (on the Tubulars screen) is longer than the wellbore depth (on the Survey screen). If all lights are green except the Main screen, press the Run icon to display a message describing the exact problem.

Note that the status light will not change colors until the screen is refreshed (by selecting another tab).

Project Description. The project file in use and the specific options selected are shown in this box. The path and name of the input data file, whether or not the data are currently saved, the system of units currently in use, and the operation options selected are indicated.

Pipe/Formation Safety Check Option. The pipe and formation safety check option is a useful new feature in CEMENT. Users requested a feature that would automatically check for dangerous pressure conditions along the entire wellbore, including both pore/frac pressure limits at all exposed formation and collapse/burst limits of the casing. Previously, only the selected Zone of Interest was rigorously checked during each run. If several zones were potential sites of lost circulation, fracking, etc., multiple runs of CEMENT were required.

The new safety check feature monitors pressures throughout the job at multiple intervals along the flow path. The minimum and maximum formation and casing pressures that occur at any time during the pumping operation are stored in memory. The results of the pipe and formation safety check are summarized in two additional graphs (minimum and maximum pressures in the annulus; and burst and collapse pressures on the tubing) and one additional table (summarizes data from both graphs). These special output screens are displayed along with the six standard graphs and tables in the Output Window (see Chapter 4).

The disadvantage of selecting this Safety Check option is a longer run time. A significantly larger number of calculations must be performed to chart pressures throughout the job at multiple depths. As an example, calculation time for the supplied example project file “Cemtest.RC” on a 100-MHz 486 computer is about 1 minute without the special safety check option and 2 minutes with the option. Therefore, if there is clearly no need to perform pressure checks all along the flow path, the user may deselect the option to speed the calculation process and make the output screen less crowded (i.e., six child windows instead of nine).
Chapter 3. Input

6 Well Data. These data provide specific information about the project to identify the company, project name, well location, date, and miscellaneous comments. Any or all of these items may be left blank if desired. The function of the program will not be affected. The maximum string length for each entry is 60 characters.

7 Calculation Status Bar. After the input data are entered, the calculation is launched by pulling down the run menu or clicking the run icon. Prior to beginning the calculations, the program automatically checks the data for errors (see Error Checking in section 3.3). As the hydraulics calculations are performed, the ongoing status is displayed in this bar with a percentage complete indicator.

3.2.2 SURVEY SCREEN

1 Survey Data Import/Export. Wellbore survey data in CEMENT can be easily shared with other MEI software. The previous standard Survey Data Input file format (*.SDI file) is fully compatible. Data previously entered in other programs can be pulled into CEMENT. Data entered into CEMENT can be stored separately for importing into other programs. Note, however, that the CEMENT Project file (accessed under the File menu) which stores all input data (including the survey) is not compatible with other software. Data sharing requires the additional step of creating an *.SDI file from this window.

Use the button to clear the survey data table (i.e., new file). The button will open an existing SDI file for importing into CEMENT. button will save the current survey data into the SDI format so that it can be imported into other MEI software. Again, note that this save button is not needed unless these survey data are to be used elsewhere.
Chapter 3. Input

2 Survey Data Units Selection. The user can specify the format for entering survey data based on the format of the source data. If inclination is entered in Degrees:Minutes, the data may be entered using a decimal point to separate degrees and minutes. A colon will be entered automatically.

3 Survey Data Columns. Wellbore survey data are entered into the first three columns of the table. Column I is Measured Depth of the survey point. Column 2 is Inclination Angle at that depth. Column 3 is Azimuth Angle at that depth. Column 4, TVD (true vertical depth), and column 5, DL (dogleg severity) are calculated quantities. The yellow background on these columns denotes they cannot be entered or edited by the user.

4 Survey Data Table. The user may input up to 600 survey positions. The survey depth in row 1 should be 0 feet or 0 meters. Survey depths must be in increasing order (i.e., descending down the hole). The measured depth, inclination angle and azimuth angle each have two unit options, independent of the general system of units selected for the overall application.

Entering/Editing Data in Tables

To enter data into tables, first click on the appropriate cell. The most straightforward technique for data entry is to type the number and then press <Enter>. This will automatically shift the cursor position for the next entry. The order of data entry when the <Enter> key is used is:

[ROW 1] Col 1, Col 2, Col 3; [ROW 2] Col 1, Col 2, Col 3; [ROW 3]......

The cursor can be moved in other directions after a number is entered. Instead of pressing <Enter>, use Control+arrow to shift to any adjoining cell. (Do not use the <Tab> key for moving between cells.)

Editing Cells

When editing individual cells of previously entered data, the arrow keys (or Control+arrow) are the best way to navigate within the table.

After a mouse click or an arrow key is used to move to the cell of interest, the default edit mode for that cell is the overwrite edit mode. Type any number or a decimal point, and the old entry will be erased and replaced by the new number.

The number edit mode allows changing only one (or more) individual digits in a previously entered cell. This mode is activated by pressing <Escape>. Use the right or left arrow to move between digits in the current entry. Single digits can be erased (using the backspace or delete keys) and new digits added. Press <Enter> (or Control+arrow) to complete the edit.

The standard Windows key combinations can also be used to copy, paste or move individual entries. Control+C will copy the selected entry; Control+V will paste; Control+X will remove the entry to the Clipboard.
Chapter 3. Input

Copying Data into Tables

Data can easily be copied into CEMENT from other applications (Excel, Lotus 1-2-3, etc.). This is especially convenient for survey data received from third parties (service companies). Open the data in Excel (etc.), arrange the data into the required column layout (for example, 1) survey MD, 2) inclination, 3) azimuth), select the data range, and copy to the Clipboard (press Control+C). To paste the data, open CEMENT, place the cursor on the upper left cell of the target range, and paste from the Clipboard (press Control+V).

Note: set the system of units to the format of the survey data (feet or meters) before importing. After importing, the survey can be converted to the desired units.

Special Repeat/Copy Feature

A special feature is included in the Survey Data Table for repeating the same value for inclination or azimuth into a range of consecutive rows. This can save typing effort (and mistakes) when a survey parameter does not change across a range of measured depths. To copy a value, position the cursor over the source cell, click and hold the right mouse button, drag the cursor down the column to the last target cell, and then release the right mouse button.

Data Table Control Buttons. The table control <Insert Line> and <Delete> keys can be used for editing the survey table data. <Insert Line> will place a new blank row above the cursor position. Delete> will clear the current selection (cell, row, or block). A confirmation pop-up box appears before any data are deleted.

Dogleg Warning Feature. The dogleg warning feature was added at the request of users. If this feature is activated, the computer will beep when the dogleg severity exceeds the limit entered by the user in the box. This alarm can be used for indicating significant errors in inclination or azimuth data. Large errors (which produce large doglegs) will be quickly found and corrected.

Survey Calculate Button. When data entry is complete, the <Calculate> button must be pressed for calculating Columns 4 and 5 in the data table. These data will also be used to generate or refresh the survey graph on the right half of the screen.

Survey Data Graph. The survey data are plotted graphically in one of three formats chosen by the user. Options, which include inclination angle with depth, dogleg severity with depth, and a 2D wellbore profile, are selected by clicking the radio buttons at the bottom of the graph area. These plots can be very helpful for spotting errors in the survey data. The currently selected graph can be sent to the printer by clicking <Print Graph>.
3.2.3 FORMATION SCREEN

1. **Survey TD and TVD.** These values are derived from the survey data and are presented on this formation data screen for reference.

2. **Show Pore and Frac Pressure in Graphs.** When pore and frac pressure limits are of interest, these can be displayed on corresponding output graphs for verifying that hydraulic pressures stay within these limits. If pore and frac pressure limits are not a concern, unselect this option. The graphs will be less crowded and easier to view.

3. **Pore and Fracture Data Format.** The user chooses whether the pore and fracture pressures are entered in units of pressure drop per unit length (psi/ft, ppg or kPa/m) or as gauge pressures at each depth. This option can be changed before or after data are entered.

4. **Trip and Kill Margins.** Trip and kill margins function as safety factors for avoiding exceeding pore or fracture limits. Typical values range from about 0.5 to 1.0 ppg above pore pressure or below frac pressure (0.026 to 0.052 psi/ft or 0.6 to 1.2 kPa/m). Exact values depend on how accurately formation behavior can be predicted. Safety margins will be plotted in corresponding graphs as restricted limits within those defined by pore/frac pressures.

5. **Pore and Frac Gradient Data Table.** Up to 100 data points (consisting of TVD, pore pressure and frac pressure) may be entered in the data table. Techniques for entering and editing data are similar to those described for the Survey Data Table in the previous section.
Chapter 3. Input

6 Data Table Control Buttons. The control buttons for the Formation Data table work only on complete rows of data. <Insert> places a new blank row above the cursor position. <Delete> clears data from one entire row, whether a single cell or whole row is selected. <Clear> clears the entire table.

7 Pore and Frac Gradient Graph. Depth and gradient data in the Formation Data table can be plotted for inspection. Click <Draw> at the bottom of the plot area to generate a new plot of the data. Click <Print Graph> to send the current plot to the printer.

3.2.4 TUBULARS SCREEN

1 Total MD and Total TVD. These values are derived from the survey data and are presented here on the tubulars screen for reference.

2 Surface Line. The effective length and ID of the surface line from the pump to the wellhead should be entered in these boxes. Default values of a 100-ft, 5-in. line are inserted by CEMENT. These parameters are used to calculate pressure drop between the pump and wellhead.

3 Tubing Geometry. The tubing/casing geometry is entered into this table. The element entered in row 1 is the deepest section. Other tubing/casing sections that will form part of the flow path are entered proceeding toward the surface. The cumulative length of tubing is automatically calculated and displayed in the right-most column. Up to 20 tubing/casing sections may be entered in the table.

Techniques for entering and editing data in the table are summarized under Survey Screen - Survey Data Table in section 3.2.2.
Chapter 3. Input

A large database of tubing/casing properties is included in CEMENT. These data are accessed by clicking the <Table> button on the lower right border of the tubing geometry table. (See also section 3 below.)

4 Wellbore Geometry. A description of each interval in the wellbore, including MD and ID, is entered in the Wellbore Geometry Table. The first entry (in row 1) should be the inner casing at the surface (the OD of the return flow annulus). The remaining intervals should be entered in order descending down the well. Up to 20 intervals may be added.

Techniques for entering and editing data in the table are summarized under Survey Screen - Survey Data Table in section 3.2.2.

If the ID of a casing string is unknown, the user can access a large database of tubing/casing properties. These data are accessed by the <Table> button on the lower right border of the wellbore geometry table. (See also section 3 below.)

5 Casing Shoe and Zone(s) of Interest. The deepest casing shoe and the MD of one, two or three zones of interest are entered in these boxes. A zone of interest is a depth for which CEMENT will calculate and display ECDs and pressure changes throughout the pumping operation. (For other depths considered in any detail, only the maximum/minimum pressures are recorded.) The bottom of the hole is often selected as a zone of interest.

6 Free Fall Control Tool. If a device to control free fall is implemented, first check the box on the left end of the top row of this box. Then enter the depth and total flow area (TFA) of the control device. The <Def.> key will insert the default location of the free fall control tool, namely, the bottom of the hole.

7 Wellbore Schematic. Click this button to jump to a graphic schematic of the current wellbore. This screen, the Wellbore Schematic/Section Volume Calculation Screen, is described under section 3.2.5.

8 Data Table Control Buttons. The control buttons for both the Tubing Geometry and Wellbore Geometry tables work only on complete rows of data. <Insert> places a new blank row above the cursor position. <Delete> clears data from one entire row, whether a single cell or whole row is selected. <Clear> clears the entire table.

The <Table> button on either table accesses the Tubular Look-Up Table. Casing strings may be selected based on nominal OD. ID can then be loaded into CEMENT automatically.

The <Vol→ID> button is used to calculate effective hole diameter when the annular volume capacity is known. A pop-up box appears; the user inputs the volume, depth interval, and casing OD.
3.2.5 Fluids Screen

Chapter 3, Fig. 9
Chapter 3. Input

3 Pumping Schedule Table. Pump schedules are displayed separately for each fluid. Enter the fluid volume and the pump rate for each fluid; the computer will calculate pumping time and cumulative time. To change to another fluid, select the fluid by clicking on the corresponding row in the Fluid Data table, or use the <Previous> and <Next> control buttons. The user can input up to ten different pump rates for each fluid.

To designate shut-in periods, first enter zero for both volume and pump rate; then enter time for shut-in. Any rate input for the native fluid/mud (first fluid) will be ignored.

4 Pumping Schedule Table Control Buttons. Each pump schedule applies to only one of the fluid stages. <Previous> and <Next> are used to cycle between the fluids listed in the Fluid Data table. The editing buttons for the Pumping Schedule table apply to complete rows of data. <Insert> places a new blank row above the cursor position. <Delete> clears data from one entire row, whether a single cell or the whole row is selected. <Clear> clears the entire table (i.e., the current fluid only).

5 Back-Pressure Schedule. Select between the options of manual input or calculated back-pressure schedule. Choosing manual input activates the time/pressure table below. If no data are entered in the table, back pressure is zero throughout the job. The automatically calculated schedule is optimized so that the back pressure will just be sufficient to prevent free fall.

6 Back-Pressure Schedule Table. Data are entered describing the planned schedule for adjusting back pressure during the operation. Enter the time of the pressure adjustment (with respect to total job time) and the choke pressure.

To devise a schedule to avoid free fall, press the <Calc...> button to invoke the Calculation of Choke Pressure to Avoid Free Fall screen. A pop-up screen is displayed for generating the optimized back-pressure schedule and displaying it in tabular and graphical formats. The data cannot be edited in the pop-up window table. Choose <Accept> to pull the generated schedule into the Fluids/Pressure Screen for editing (for example, removing or combining time steps). Not editing these data after accepting them is essentially equivalent to choosing “Calculate to Prevent Free Fall” instead of “Manual Input” (see 5 above).

7 Wellbore Schematic. Click this button to jump to a schematic of the current wellbore. This screen, the Wellbore Schematic/Section Volume Calculation Screen, is described in the next section.
Chapter 3. Input

Wellbore Schematic/Section Volume Calculation Screen

The Wellbore Schematic/Section Volume Calculation screen is a pop-up screen accessed from CEMENT input windows. This screen is activated by clicking the <Wellbore Schematic> button on either the Tubulars screen or Fluids screen. To return to the previous screen, press <Close> at the bottom right corner.

1. **Wellbore Schematic.** The current wellbore hole and casing geometry are shown schematically. The primary zone of interest (selected on the Tubulars Screen) is indicated on the schematic with a red “O” (at the bottom of the hole at 9300 ft in the figure). Wellbore inclination is plotted to the right of the wellbore. (The example above is a straight vertical well.)

2. **Selected Wellbore Interval.** If an interval has been selected by the user for a volume calculation, the selected interval will be shown in the wellbore schematic as a colored zone. Blue represents the interval inside tubing; green is the selected annular section.

3. **Volume in Selected Interval.** The calculated volume of fluid within the selected depth interval is shown for inside tubing (upper box) and in the annulus (lower box).

4. **Total Volume.** The total fluid volume inside the tubing/casing and in the annulus is shown for comparison.
Chapter 3. Input

5 TVD of Selected Interval. The beginning and ending TVD (true vertical depth) of the interval selected by the user for a volume calculation is shown in these boxes. These values cannot be entered directly, but may be adjusted by clicking on the wellbore schematic at the desired depths, once to set the upper bound and again to set the lower bound. Alternatively, enter the bounding MDs in the boxes above.

6 MD of Selected Wellbore Interval. These boxes are used for directly entering the measured depths for the selected interval for a volume calculation. This method can be used instead of clicking with the mouse. Enter a depth of zero to start from the surface.

3.2.6 INPUT SCREEN MENUS

The menu system used in CEMENT is very similar to other Windows applications. Most functions are self-explanatory. There are five menus in the Input Screens of CEMENT: File, Run, Output, Utility and Help.

File Menu

The File menu contains commands for creating, retrieving, saving and printing input data. Users familiar with CEMENT 1 will notice a significant difference in file management with CEMENT 2.0. In CEMENT 1, four files were used to store input data segregated by type (i.e., well description in *.WDI file; wellbore survey data in *.SDI file; tubular data in *.TDI file; and parametric data in *.PDI file). A project file (*.CEM) was used to keep track of the names and folders for the data files.

In CEMENT 2.0, all data are stored in a single file. Consequently, the File menu is simplified. The functions of the individual menu options are:

1. “New File” clears all five input screens and displays a null project data file in the Project Window.
2. “Open File...” opens a dialog box for exploring the file system for input files with the extension “.RC1.” This window functions as in other Windows applications.
3. “Save File” replaces the previous version of the input data file with the current modifications. No prompt is given before overwriting the previous version of the file.
4. “Save File As...” saves the current version of the input data under a different name. A dialog box is opened to let the user specify the drive, directory, and name of the project file.
5. “Print Data Report” prints a specially designed form displaying all current input data and parameters.
6. “Data Report Preview...” leads to a pop-up window for previewing the input data report. After viewing, the data report can be sent to the printer or copied to the Clipboard.
7. “Print Window” sends the current window (whichever tab is selected) to be printed (in graphical form) including all current data in that window.
8. “Exit” concludes the current session. CEMENT will prompt for saving the project file if data have been changed and not yet saved.
Chapter 3. Input

Run Menu

The Run menu is used to launch CEMENT's hydraulics calculations. Click “Start” after all input data are entered. CEMENT will check for errors in the data (e.g., casing ID larger than OD, etc.) prior to performing the calculations. The run icon can also be used to launch the calculation.

The Calculation Status Bar (upper right corner of the input screen) will display the progress of the calculation (from 0 to 100% complete). Due to the great number of calculations to be performed, a typical run may require a minute or more. After the calculations are completed, the Output Window will be loaded automatically.

Output Menu

The Output menu can be used to switch from the main input windows to the output window. However, since this action is performed automatically after a calculation, this menu does not normally need to be accessed. This command (and the corresponding icon ) is useful, however, when the user switches back to the Main Window from the Output Window to review the input data, and then wishes to return to the Output Window without recalculating.

Utility Menu

The Utility menu contains a command for selecting the system of units displayed in the input and output numeric boxes and graphs. Clicking “Units...” opens the......

System of Units Selection Screen
Chapter 3. Input

1. **Units Table.** Physical parameters and currently assigned units for each quantity are displayed in the Units Table. The user cannot edit this table directly (indicated by yellow background). Allowable options for each quantity are accessed by pulling down the drop-down box attached to each quantity (see 4 Units Pull-Down Box below).

2. **Custom Units Control Buttons.** If any changes are made to the default English or SI systems of units by selecting another option from one or more of the pull-down boxes, the new custom system will need to be saved for future use. Use the <Save> button for new custom systems or updates to previously created systems. The <Save As...> button is used when a new combination of units is designed, and the user wishes to save it separately, rather than overwriting the previous custom system. Both save buttons will cause a save dialog box to pop up. Custom systems of units are stored as *.UNT files.

The <Print> button will print the System of Units Selection Table for documentation or reference.

3. **System of Units Selection Buttons.** These buttons select entire systems of units, which then appear in the table, and in all CEMENT screens and graphs. The <Other> button will display the file names of the custom systems previously created and stored.

The name of the currently selected system of units is displayed in the upper left corner of the System of Units Selection Screen (“(Default English)” in the figure above).

4. **Units Pull-Down Box.** The allowable options for each engineering quantity are accessed by pressing the down arrow at the right of the column entitled “Selection.” The options box for pressure units has been pulled down in the figure as an example.

5. **Numeric Display Format Table.** The number of digits displayed for each parameter can be adjusted by the user. The number of zeroes after the decimal point for each quantity will be used as standard for the printouts. Note that the number of zeroes in the spreadsheet input tables on the screen cannot currently be adjusted by the user.

6. **Control Buttons.** These buttons control operations for the entire units screen. <OK> accepts the current settings after any changes are made and then returns to the previous screen. <Cancel> ignores any changes made since this units screen was activated and then returns to the previous screen. <Undo All> deletes all changes made since this units screen was activated, but stays in the units screen for further changes.

**Help Menu**

The Help menu provides information for obtaining additional assistance with CEMENT and describes the user’s computer.

1. “Help Topics...” launches the CEMENT Help system.
2. “Assistance...” opens a pop-up box which displays MEI’s address, phone number, e-mail address and other information. Use these contacts to obtain additional help with CEMENT.
Chapter 3. Input

3. “About...” opens the “About” pop-up box, which displays the version number of CEMENT along with hardware in the user’s computer.

4. “Feedback” opens a special screen form for documenting specific bugs, problems, etc. and communicating with MEI. The form can be printed for faxing or saved to disk and attached to an email routed to mei@maureng.com.

3.3 ERROR DETECTION FOR INPUT DATA

CEMENT includes basic routines for detecting obvious errors in the input data. These routines are run as soon as the Run command is activated (under the Run menu or run icon). When input data are outside the boundaries and/or appropriate range of values, the error-checking routines will detect the error. The program will halt calculation, display an error message describing the problem, and allow the user to go back and correct the data.

Obviously, CEMENT is not capable of detecting small errors in the input data (i.e., when the incorrect parameters represent solutions that are physically reasonable), but the error checks will help prevent simple typing mistakes from having an enormous impact on the results.

In some cases, it may be difficult to discern on which screen the error was detected. Look at the upper left corner of the error box for the name of the input screen.

If no errors are detected, the entire hydraulics calculation sequence is completed for the wellbore. A calculation progress indicator is displayed in the upper right corner of the screen.

Due to the large number of calculations, a run time of 1 to 2 minutes is not unusual. After the calculation sequence is complete, the output windows are automatically loaded.
4. Output

4.1 INTRODUCTION

A great variety of output data is generated by CEMENT for evaluation by the engineer. Output presentations include seven X-Y graphs and two tables. The format of the printouts is very concise and informative. After being customized by the addition of your company's logo, the printouts are ready for inserting into proposals, reports, etc.

The tables present numeric values of all important hydraulics parameters. The user can select specific parameters to be printed in the tables. The graphs present the same data as the tables, and the graphical format highlights trends and trouble spots for rapid evaluation and correction. Modifications to parameters can be rapidly implemented and tested by returning to the input screen, changing any parameter(s), and recalculating.

4.2 THE OUTPUT WINDOW

The Output Window of CEMENT is loaded automatically after the calculation sequence is completed in the Input Window. The results of the hydraulics analyses are presented in a variety of useful graphs, as well as in tabular format. Options are provided to view the graphs individually or in groups, to easily customize the output for specific applications, to document the results in professional-style printouts, to copy data to the Clipboard for importing into Word, WordPerfect, Excel, PowerPoint, etc., as well as several other convenient features. Screens accessible within the output section of CEMENT and all corresponding functions are described in turn in the following sections.

4.2.1 MAIN OUTPUT SCREEN
Chapter 4. Output

The Output Screen is the central navigating point inside the output section of CEMENT. This window appears first after the calculations are completed. Nine tiled windows will be displayed if the special Pipe/Formation Safety Check option is selected (see section 3.2.1); six tiled windows will be displayed if the safety check option is not selected.

1 Menu Bar. The pull-down menus in CEMENT output are used to arrange output presentation, export data, select options for graph design, and several other useful functions. A description of functions and features of the output menus is presented later in this chapter in section 4.2.6.

2 Tool Bar. Tool bar icons can be used to quickly access commonly used functions from the menus. The functions of CEMENT's output screen icons are:

- **Print.** Prints the currently focused (or maximized) graph or table. Graph printouts include a summary of the input and output data in a table above the graph.

- **Copy to Clipboard.** Exports the currently focused graph or table to the Clipboard in either bitmap or metafile format. The format is selected in the Graph Style Window under “Image Format.” From the Clipboard, the data can easily be pasted into other Windows applications.

- **Save.** Saves the currently focused graph or table to disk in either bitmap or metafile format. The format is selected in the Graph Style Window under “Image Format.”

- **Main Window.** Returns to the main Project Window (i.e., the Input Window) for reviewing and/or editing input data.

- **Tile Windows.** Displays all currently active (i.e., not minimized) graphs and tables in vertical tiled format. This button is also useful for refreshing the Output Screen display after changes are made in graph style parameters, or the number of graphs and tables is changed via minimizing, restoring, etc.

- **Flow Animation.** Go to the Flow Animation screen. (See section 4.2.2.)

- **Well Schematic Preview.** Go to Well Schematic Preview window to view the output graph prior to printing. (See section 4.2.3)

- **Report Setup.** Invokes a pop-up screen for selecting variables and the time interval to be included in the simulation report. (See section 4.2.4.)

- **Graph Setup.** Invokes a pop-up screen for selecting variables and axis titles to be used on output graphs. (See section 4.2.5.) Note: Additional features can be adjusted for individual graphs by clicking on the right mouse button.

- **Help.** Launches the CEMENT Help System.

- **Calculator.** Pops up the Windows utility calculator.

3 Graph and Table Windows. The output from CEMENT is presented for evaluation in nine tiled windows. In each graph window, the curves to be shown or hidden can be selected through the Graph Setup Window. The number of curves in each graph cannot exceed four. The attributes of the graph, such as title, legends, caption, print style, and the format (bitmap or metafile) used when the graph is written to disk can be set using the “Attribute Setup...” command in the “Graph Output” menu.
Chapter 4. Output

The first six graph and table windows are presented for all runs. These include:

1. **Simulation Report.** The simulation presents parameters calculated by CEMENT in a table format. Each item in the report table is optional; the user can select which parameters are included by Report Setup Window (see section 4.1.4). The time range and time increment can also be adjusted in Report Setup. Use the horizontal and vertical scroll bars for navigating through the table.

2. **Flow Rates versus Elapsed Time.** A comparison of the rate in and rate out curves effectively illustrates the impact of free fall on returns. (If rate in and rate out match throughout the operation, the rate out trace may not be visible.)

3. **Free Fall and Fluid Front versus Elapsed Time.** By default, only the free fall section length is shown in this graph. The user can also select to display the leading edges of any fluids (use Graph Setup). In this way, the influence of each fluid on free fall can be evaluated.

4. **Pressure versus Elapsed Time.** Pressure at the primary zone of interest is plotted for the job. The wellhead pressure is also shown, along with fracture and pore pressure (if these were input by the user in the Fluids input screen, and “Show pore and fracture pressure in output” is selected). The predicted bottom-hole pressure can be compared with critical conditions. Modifications can then be made to job design to correct problems, such as formation breakdown occurring or pore fluid flowing into the wellbore.

5. **Equivalent Circulating Density (ECD) versus Elapsed Time.** The equivalent circulating density at the primary zone of interest is plotted for the job along with the fracture and pore equivalent mud weight (provided these are not zero).

6. **Free Fall Pit Gain versus Elapsed Time.** The fluid volume over or under the expected rate (based on rate in) that enters the pit is plotted for the job. This graph helps in planning field operations and well-control procedures for the job.

Output windows 7 through 9 are also included in the Output Screen if the option to perform a safety check of the pipe and formation has been selected in the Main Screen (see figure).

7. **Formation/Pipe Safety Check Report.** This table summarizes minimum and maximum pressures in the annulus at 1000-ft intervals. Pipe burst and collapse pressures are also compared at the same multiple depths.

8. **Minimum/Maximum Annular Pressure Profile.** The minimum and maximum pressures in the annulus are plotted for all sections of the wellbore with exposed formation. Pore and frac pressure limits are shown for highlighting depths where lost circulation or fluid influx are predicted.

9. **Tubing Burst/Collapse Pressure.** Maximum burst and collapse pressures on the casing string during the cementing operation are plotted along the entire string. These can be compared with burst and collapse ratings for the string. Burst and collapse strengths are calculated based on the casing strength (Tubulars input screen).
Chapter 4. Output

4 Window Control Buttons. The standard Windows 95 control buttons can be very useful for maximizing and minimizing individual graphs for rapid review and evaluation of results. The button will enlarge a tiled graph or table to occupy the full screen. The button will minimize a graph or plot (i.e., convert it to an icon at the bottom of the screen). To reactivate a minimized plot, press to replace the graph into the tiled screen or to zoom the graph to full screen. The button will temporarily turn off a graph; however, a closed graph is not turned off permanently and will be redrawn the next time the tiled screen is refreshed. Use the minimize button if you wish to hide a plot that is not of interest for a particular job operation.

Note: another convenient feature was added for rapidly reviewing the graphs. When in the tiled display format, double-click anywhere on a graph to maximize it. Review the plot, and double-click again to restore the tiled display.

4.2.2 FLOW ANIMATION SCREEN

Wellbore Schematic with Fluid Fronts. Positions of fluid stages are shown in the wellbore schematic. To show a snapshot of the fluid positions at a particular time(s), 1) run the animation (click <Start>) and allow the entire operation to be completed or press <Pause> at any point, or 2) enter a specific time to display in the Show Fluids at box (see 5).
Chapter 4. Output

2. Wellbore Schematic with Flow Regimes. The left side of the schematic will show the flow regime of each stage in the casing and in the annulus. The regime option is activated by clicking <Flow Pattern> in the Animation Control box (3). The patterns are defined in the flow regime legend in the lower right corner.

3. Animation Control Buttons. The flow animation is controlled with these buttons. <Start> begins the job simulation from time 0:00. <Pause> will halt fluid movement at any specific time of interest. <Cont.> will continue the simulation from the time the run was paused. <Quit> clears the fluid fronts in preparation for a new run. <Flow Pattern> displays fluid flow regimes on the left half of the schematic. This option is active only after the simulation has been completed or paused. The speed of the simulation can also be adjusted by the user for optimizing the benefits of viewing the simulated operation. Enter any number between 1 and 2000 in the Animation Speed box (1 is actual speed of field operations).

4. Tabulated Data. Time and hydraulics data are displayed in numeric form at the specific time selected for the zone of interest. These data may not be edited from this screen.

5. Screen Control Buttons. <Close> is used to close the animation screen and return to the Output Window. <Preview...> activates the Well Schematic Preview window (see section 4.2.3).

6. Flow Pattern Legend. This table presents the legend for fluid flow regimes depicted in the wellbore schematic (after clicking <Flow Pattern>). These patterns may not be edited by the user.

7. Fluid Legend. Each fluid stage is summarized in this table. The fluids are keyed to the animation by color. Data in the fluid legend cannot be edited from this window. (Return to Fluids window for edits and recalculate.)

8. Time Step Control. Very sensitive control of the animation is possible by using the time-step control keys. Set the time step (the time interval advance for each click) in the Time Step box. The default value of the time step divides the job into 20 intervals. Use the ▶ button to advance the fluid positions one time step; ▼ runs the job back one time step; ▼ moves directly to the end of the job; ▼ returns to the beginning. <Redraw> will refresh the screen (if required) after the time step is changed.

9. Pressure Graph. Pressure at the surface (pump pressure) and pressure at the zone of interest are plotted as the job progresses. If Show pore and fracture pressure in output is checked on the Formation Screen input, pore and fracture pressure lines will be displayed in the pressure graph. These will clearly illustrate those periods during the job when formation limits were exceeded.

10. Pressure Alarm. If this box is checked, the program will cause a warning beep (your Windows default sound) if pressure exceeds fracture or pore pressure limits at the bottom of the hole. A yellow text box appears at the bottom of the inclination graph to indicate lost circulation (exceeding fracture pressure) or taking a kick (falling below pore pressure).
Chapter 4. Output

4.2.3 WELL SCHEMATIC PREVIEW WINDOW

The Well Schematic Preview window is used for selecting and adjusting the wellbore schematic page prior to printing. This window is accessed by selecting “Well Schematic Preview...” under the Window menu or by clicking the icon.

1. **Wellbore Schematic with Fluid Fronts.** The wellbore fluid front printout is displayed in the preview window in WYSIWYG (what you see is what you get) format. The user can select the exact snapshot in time during the cementing job to be shown in the graph.

2. **Time Selection Box.** These buttons and boxes are used to set the time of the snapshot of the cementing job. The default time increment shown in the box divides the pumping operation into 20 equal time steps. The user can change the time step to show smaller or larger intervals between snapshots of the fluid positions. After the time step is set, use the button to advance the fluid positions one time step; runs the job back one time step; moves directly to the end of the job; returns to the beginning.

3. **Zoom Control.** Six preset zooms are provided for viewing the fluid front printout. Zoom in to see the fluid positions in fine detail; zoom out to view the entire page including project identification and fluid legend.

4. **Screen Control Buttons.** Click <Print> to send the current snapshot of the well flow schematic to the printer. Click <Copy> to copy the entire page to the Clipboard for importing into other Windows applications. The export format options for the graph are bitmap or metafile, which are selected in the Graph Style menu under “Image Format.”
4.2.4 REPORT SETUP WINDOW

The Report Setup Window is used to customize the Simulation Report (see section 4.2.1) by changing the data resolution (time step between the rows) and the parameters that appear in the printout. This window is accessed by the Output Setup menu or clicking the icon.

1. **Time Interval and Increment.** The time interval printed in the report can be selected by the user (i.e., all or only part of the job). Data resolution can be adjusted to show more or fewer points in the printout (i.e., fewer rows in the table). Note that the entire job is divided into 500 time steps which are calculated by CEMENT and stored in memory. Data points are skipped when fewer than 500 points are to be shown in the report. Consequently, the Number of points (shown just below settings table) will not necessarily equal the time interval divided by the data resolution, but will assume values that are readily divisible into 500.

2. **Parameter Selection.** Select all parameters of interest for printing in the report. Each parameter will be listed in a separate column. Page-width limits dictate that a maximum of nine parameters can be displayed on one report. Preview the report by maximizing the "Simulation Report" window.

3. **Fluid Front Selection.** The position of the leading edge of any fluid can be selected as a parameter to be charted in the report. Each fluid front selected requires one column. The nine-column limit includes fluid fronts.

4. **Screen Control Buttons.** Click <OK> to accept the current choices and return to the Output Window. Click <Cancel> to abandon any changes and return to previous settings. <Default> will abandon changes and restore original default settings.
Chapter 4. Output

4.2.5 GRAPH SETUP WINDOW

The Graph Setup Window is used for customizing the titles and parameters shown in the output graphs. This window is accessed through the **Output Setup** menu or by clicking the icon.

1. **Y-Axis Parameter Selection.** The user can customize individual graphs by adding or removing specific curves. Select y-axis parameters to be plotted in their respective graphs by clicking on the check box next to the parameter. A maximum of four y-axis parameters can be plotted in any single graph.

2. **Graph Selection.** When changing graph titles or legends, the first step is to select a specific graph. Access the drop-down box displaying all available options by clicking at the right side of this box.

3. **Title Edit Boxes.** The title of the graph and the x- and y-axis labels may be edited. Note that changes are not saved from session to session.

4. **Legend Labels.** Edit legend labels for any of the graphs in these boxes.

5. **X-Axis Parameter Selection.** The changes in each parameter as the pumping operation progresses can be viewed over job time or as related to total pumped fluid volume.

6. **Screen Control Buttons.** <OK> exits the Graph Setup screen and implements any new modifications. <Cancel> exits the Graph Setup screen and ignores any new modifications. <Default> restores all default settings for parameter choices and titles.
4. OUTPUT SCREEN MENUS

The menu system design used in CEMENT is similar to other Windows applications. Many functions are self-explanatory. Several of the most commonly used menu functions can be easily accessed through the tool bar icons (see section 4.2.1). There are five menus in the Output Screen of CEMENT: File, Window, Output Setup, Graph Style and Help.

**File Menu**

The **File** menu contains commands for printing, exporting, and saving output data. The functions of the individual menu options are:

1. **Print Report/Graph** prints a high-quality image of the graph in the currently active graph window at the full resolution of the printer. The selected graph will be printed on the bottom half of the page. Summary operational and parametric data will be printed in a table above the graph. With this format, the graph is very easy to analyze and share with clients, colleagues, etc. CEMENT also offers the option of printing in color. If a color printer is available, select “color” in the **Graph Style** menu under “Print Style”. Printing in color on a monochrome printer will cause the printer to use gray scale instead of colors, and may not produce satisfactory results. To include your company's logo on the printout, place a bitmap of the logo entitled “Clogo.bmp” into the local CEMENT directory.

2. **Copy Report/Graph to Clipboard** copies the focused graph or report to the Clipboard in either bitmap (.BMP) or metafile (.WMF) format. The format is selected in the **Graph Style** menu under “Image Style.”

3. **Save Graph to File...** opens a dialog box. The user can specify the drive, directory, and the name of the image file. The image of the graph is written to disk as a bitmap (.BMP) or metafile (.WMF). The format is selected in the **Graph Style** menu under “Image Format.”

4. **Save Report As...** opens a dialog box. The user specifies the drive, directory, and name of the text report file. The format of the report is ASCII text with space delimiters.

5. **Return to Project Window** is used to transfer back to the Main Project Window for reviewing or modifying input data. If, after reviewing the input screens, you wish to return to the output section without making any changes to the input data, select “Show Results” from the **Output** menu or click the icon. This saves time by not launching the calculation sequence if no data were changed.
Chapter 4. Output

Window Menu

The Window menu contains commands for arranging the output graphs and tables on the screen. The first four options relate to the simultaneous display of all output (i.e., all non-minimized graphs and tables).

1. “Cascade” arranges the graphs and tables in a front to back display with the title block of each graph window remaining visible. The program adjusts the size of each open window to occupy the same amount of display space. The windows are then stacked starting from the upper left corner of the Output Window. Individual plots can be pulled to the top of the stack for viewing by clicking on their title blocks or by selecting them from the list (numbers 1 through 9) in the Window menu.

2. “Tile Horizontally” arranges the six output graphs and tables into three rows of two graphs each. The displayed graphs are relatively wide and emphasize the x axis. Note that this option is not active if nine plots are displayed, i.e., if “Perform Pipe/Formation Safety Check” is activated.

3. “Tile Vertically” arranges six output graphs and tables into two rows with three graphs each (or all nine in a three by three pattern if the safety-check option is selected). The tiled graphs are approximately square with equal emphasis of x and y axes. This is the default arrangement when the output screen is first loaded after the calculation sequence.

4. “Arrange Icons” restores the alignment of your report and graph window icons (used in Windows 3.x).

5. “All” and Graphs and Tables numbers 1 to 9 select the current output display. “All” shows all active plots simultaneously in a tiled or cascaded format. Selecting an individual plot number has a different effect depending on the current display format.

If the output screen currently is...

A full-size maximized graph
A cascaded (stacked) display
A tiled display

...Clicking Menu Item 1 to 9 will display that selection as...

A full-size maximized graph.
The top of the stack.
Unchanged, but with the focus moved.

6. “Flow Animation...” pulls up the flow animation screen for viewing a simulation of the cementing operation. (See section 4.2.2.)

7. “Well Schematic Preview...” pulls up a window for previewing the wellbore and flow front schematic for inspection and adjustment prior to printing or exporting. (See section 4.2.3.)
Chapter 4. Output

Output Setup Menu

The Output Setup menu contains commands for customizing the parameters and titles in the graphs and tables. The options include:

1. “Report Setup...” invokes the Report Setup window (see section 4.2.4) for selecting quantities and ranges for the Simulation Report.

2. “Graph Setup...” pulls up the Graph Setup window (see section 4.2.5) for selecting parameters to be displayed on each plot, and allows the user to customize graph titles and legends.

Graph Style Menu

The Graph Style menu contains commands for customizing the graph display styles for screen display and printing. These commands allow you to design interactively using several style options. Styles selected under Graph Style will affect all graphs. Note that the effect of a change in style options may not be observed immediately after the Graph Style menu item is selected. The new styles will be incorporated the next time the graph is redrawn (e.g., by resizing an individual plot). Display features for individual graphs can be modified by clicking on the right mouse button while in the Main Output Screen. Graph Style menu options include:

1. “Screen Display” provides the options of “Monochrome” (i.e., black and white) and “Color.” This applies only to screen presentations of graphs. Black and white printers are selected with the option “Print Style” below.

2. “Borders” provides the option of adding a border to graph printouts.

3. “Grids” provides the options of 1) no grid lines in the graphs (i.e., only tick marks on the x and y axes), 2) horizontal grid lines only, 3) vertical grid lines only, or 4) both horizontal and vertical grid lines. The default selection is both horizontal and vertical grid lines.

4. “Lines” provides options for changing the width of lines or selecting patterns for discontinuous lines. Changes in line style apply to all lines.

5. “Symbols” provides the option of including data symbols along with plot lines in the graphs.

6. “Legend” provides the option of including a legend with the graphs.

7. “Print Style” is used to select black and white or color output to be sent to the printer.

8. “Image Format” selects the format for exporting tables and graphs. Options include bit map “*.BMP” (default) or Windows metafile “*.WMF.” The principal difference is that a metafile can be scaled proportionally, while a bitmap cannot. A metafile is usually more suitable for copying via the Clipboard to a Word or WordPerfect document, PowerPoint presentation, etc. However, a bitmap can be edited in Paintbrush on a pixel-by-pixel basis.
Chapter 4. Output

9. "Default Style" sets all above styles to the default values, which are:

- **Screen Display:** Color
- **Borders:** Fixed
- **Grids:** Both
- **Lines:** Thicker Line 3
- **Symbols:** None
- **Legend:** Included

Help Menu

The **Help** menu provides information for obtaining additional assistance with CEMENT and describes the user's computer.

1. "Help Topics..." launches the CEMENT Help system.
2. "Assistance..." opens a pop-up box which displays MEI's address, phone number, e-mail address and other information. Use these contacts to obtain additional help with CEMENT.
3. "About..." opens the "About" pop-up box, which displays the version number of CEMENT along with hardware in the user's computer.
5. Getting Help

5.1 CONTACTING MEI

For additional assistance with installation or operation of CEMENT, contact:

Gefei Liu or Lee Chu  
MAURER ENGINEERING INC.  
2916 West T.C. Jester Boulevard  
Houston, Texas 77018-7098 U.S.A.

Telephone: (713) 683-8227  
Fax: (713) 683-6418  
E-mail: mei@maureng.com

5.2 REPORTING PROBLEMS

Even though CEMENT 2.0 has been carefully checked before its release, software bugs are a fact of life. Please report to us any bugs you find and describe the input parameters and conditions selected when the bug occurred.

MEI is also very appreciative of your comments and suggestions for improving CEMENT. Let us know if there are additional features you would like to see added to the program. Though it may not be feasible to incorporate every suggestion into the next version, many important improvements have been made to this and other MEI programs based directly on suggestions from users.

Please use the form on the next page to report bugs in the program, as well as suggestions on improving the function and usefulness of CEMENT.

© 1997 Maurer Engineering Inc.
**Bug Report/Enhancement Suggestion Form**

Name: ___________________________ Company: ___________________________
Address: ___________________________ City: ___________________________ State: ______
Phone No.: ___________________________ Fax No.: ___________________________
E-mail: ___________________________ Date: ___________________________

☐ Bug/Problem Report

☐ Enhancement Suggestion

**Program Name and Version Number:** ___________________________

**Bug/Problem Description or Suggested Enhancement:**

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

**Other Comments:**

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

**Data/Parameters Causing Bug**

☐ Will be mailed on diskette ☐ Will be faxed ☐ Attached ☐ None

**Operating System**

MS-DOS Version No.: ________
OS2
Other

MS-Windows Version No.: ________ (Win 3.1/Win 95)

MS-Windows NT Version No.: ________

**Please mail, fax, or e-mail to:**

Lee Chu
MAURER ENGINEERING INC.
2916 West T.C. Jester
Houston, TX 77018-7098
Ph: 713/683-8227 • Fax: 713/683-6418
E-mail: mei@maureng.com

© 1997 Maurer Engineering Inc.
Chapter 5. Getting Help
Appendix A — Common Problems and Solutions

Specific problems related to installing and running MEI software are described in this section. These problems have been reported by multiple users and are often related to computer settings and file locations.

A.1 INTERNATIONAL KEYBOARD SETTINGS

"Type Mismatch" Error

All computer software developed at Maurer Engineering Inc. is written using the U.S. Keyboard format. Under this numeric standard, the 1000 separator is a comma, and the decimal separator is a period. Thus, the number one thousand, two hundred and thirty-four and 22/100 is written as

\[ 1,234.22 \]

Numbers input into MEI programs are stored in this format.

Problems have occurred for some of our clients who use the International Keyboard format, as is common in certain countries in Europe and South America. Here, the same number would be written

\[ 1.234,22 \]

where the 1000 separator is a period, and the decimal separator is a comma.

Users with the International Keyboard format find that their computers garble input data being loaded into MEI programs. Often, a "Type Mismatch" error halts the program.

This problem can be readily solved by changing the Windows numbers format from International to U.S. format. This can be accomplished as follows:

In Window 3.x

1. Select the "Control Panel" icon from the Main menu screen. This is done by pointing the mouse to this icon and double clicking. This brings up the "Control Panel" menu screen, as shown below.
2. Select the “International” icon from this menu screen by pointing to it with the mouse and double clicking. This brings up the International Menu screen.

3. In the lower right corner of the “International” menu screen is the “Number Format.” If the number under the words “Number Format” is 1,234.22, MEI programs should run successfully. Click <Cancel> to back out of this screen.

   If the number under the words “Number Format” is 1.234,22, it must be changed before MEI programs will run successfully.

4. To change the number format, click on the “Change” button in the “Number Format” box on the screen. This will bring up the “International—Number Format” screen. Change the “1000 Separator” from a decimal to a comma. Next, highlight the “Decimal Separator” box and erase the comma from the box and replace it with a period.

4. Click <OK> to exit the “International—Number Format” box. Click <OK> to return to the Main menu screen.

In Windows 95

1. Select “Settings” → “Control Panel” from under the Start menu. This brings up the “Control Panel” menu screen, as shown below.

   ![Control Panel Menu](image)

   2. Double-click the “Regional Settings” icon.

   3. The simplest method to change the number format is to select “English (United States)” from the dropdown list on the “Regional Settings” page. This changes all conventions to U.S. format. To change only the number format, click on the “Number” tab and change the Decimal symbol to “.” and the Digit grouping symbol to “,”. You may have to restart your computer for these changes to take effect.
A.2 POTENTIAL LIBRARY FILE PROBLEMS

Most of Maurer Engineering's computer programs are MS Windows-based programs which run under Windows 3.x, Windows 95, and Windows NT operating systems. When our Windows programs are run, several library files are needed (.VBX, .OCX, .DLL, and .EXE) to support the Windows interface functions. These library files might also be used by other Windows programs, which means all types of Windows applications theoretically can share the same library file from a "common library."

The basic concept of a common library is sound. Since one library file may support many programs, storing the library once in an accessible location saves space on the hard drive. However, because of compatibility issues with different versions of the same library files, the wrong library version can cause a program error. Programs developed/compiled with older versions of library files may not run with newer versions or vice versa.

When running a Windows application, Windows searches for required library files in the following sequence:

1. the Windows\System\ subdirectory
2. the Windows\ subdirectory
3. the local program subdirectory which contains the executable application .EXE file

These rules were established by Microsoft and, unfortunately, may lead to serious problems. Placing the wrong version of the common library into the Windows\System\ subdirectory will cause all programs which use a different version of that library file(s) to malfunction. Maurer Engineering has received many reports of problems with our software after users have installed another company's software. These problems are the result of the third party software installing its own (different) version of the library into the Windows\System\ subdirectory. This new version then gets priority over the correct version in the local ME1 subdirectory.

All MEI Windows programs install the required library into the local program subdirectory to avoid conflict with other programs already installed. Though this method requires slightly more disk space be reserved for libraries, this is the safest approach. If this procedure is followed, users should not be apprehensive about installing MEI's programs.

If a user finds that an MEI program will not run or the output graphs will not display, the following procedure should solve any library incompatibility problems.

1. Most of the time, MEI's programs will display an error message to indicate which library files are incompatible. If so, go to Step 4.
2. Look at the specific program's subdirectory to find all the library files needed by the program. Usually, the library file extensions are .VBX, .OCX, .DLL, .EXE.
3. Check the Windows\System\ and Windows\ subdirectories to see if there is a different version of the library file (different size or different date) stored there.
4. Move these library files from the Windows\System\ or Windows\ subdirectories to a temporary subdirectory (do not erase these files) to determine whether library incompatibility is the problem. If these files are used by another (non-MEI) program, copy these files to the other program's subdirectory.

The following library files most frequently cause problems: GRAPH.VBX, GSWDLL.DLL, GSW.EXE, GSWAG16.DLL, GSW16.EXE, VBDB300.DLL, THREED.VBX, and GRID.VBX.

If the problems persists after these steps are taken, please contact MEI.

© 1997 Maurer Engineering Inc.
A.3 PRINTER SELECTION

MEI programs support a wide range of monochrome and color printers. However, most programs written in Visual Basic 3 (16-bit) do not provide options within the program for selecting individual printers. All print jobs are sent to the current Windows default printer.

Changing Printers

If you wish to switch to a special printer, **assign that printer as the Windows default printer before running the MEI program.** The default printer is selected under the Printers control window. This window is accessed in Windows 95 by selecting **Start → “Settings” → “Printers”**. After the Printers window is open, click once on the printer of interest to highlight it. Then, select “Set as Default” from the **File** menu.

Network Printers

Some users have experienced problems when trying to send output from MEI software to network printers. Most difficulties can be addressed by modifying the printer port entry. If a network printer will not print from an MEI program, follow these steps:

1. Select **Start → “Settings” → “Printers”;** then double-click the network printer icon.
2. Select “Properties” from the **Printer** menu. Select the “Details” tab from the Properties window (see figure).
3. Place the cursor on the entry in the text box under **Print to the following port:** Copy the text string by pressing control+C.
4. Click the “Capture Printer Port...” button.
5. Select “LPT2” or “LPT3” under the **Device** pull-down menu.
6. Click the **Path:** text box; then paste the text string into the box by pressing control+V. Click <OK> to close the “Capture Printer Port” window.
7. On the “Details” window, pull down the list of options under the **Print to the following port:** box. Select the new entry (that you just created) with “LPT2” or “LPT3” followed by the text string copied and pasted.
8. Select <OK> and close all printer windows.

This procedure should allow printing to a network printer, provided that printer is also selected as the Windows default printer.

© 1997 Maurer Engineering Inc.